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CE Declaration 

We: 

TerraTec Electronic GmbH, Herrenpfad 38, D-41334 Nettetal, Germany 

hereby declare that the product: 

VideoSystem Cameo 400 AV mobile 

to which this declaration refers is in compliance with the following standards or standardizing 
documents: 

1. EN 55022 Class B 

2. EN 55024 

The following are the stipulated operating and environmental conditions for said compliance: 

residential, business and commercial environments and small-company environments. 

This declaration is based on: 

Test report(s) of the EMC testing laboratory 

  

 

 

 

 

 

 

 

 

 

The information in this document is subject to change without notice and shall not be deemed as a warranty by the 

seller. No warranties, express or implied, are made with regard to the quality, suitability or accuracy of this 

document. The manufacturer reserves the right to change the contents of this document and/or the associated 

products at any time without the provision of prior notice to specific persons or organizations. The manufacturer 

shall not be held liable for damages of any kind arising from the use, or the inability to use this product or its 

documentation, even if the possibility of such damage is known. The information in this document is subject to 

copyright. All rights are reserved. No part of this manual may be reproduced or transmitted in any form or for any 

purpose without the express written permission of the copyright holders. Product and brand names contained in 

this document are used for identification purposes only. All registered trademarks, product designations or brand 

names used in this document are the registered property of their respective owners. 

©TerraTec® Electronic GmbH, 1994-2003. All rights reserved (12.11.03). 
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Preface 

Thank you for choosing a TerraTec product. Congratulations on your decision to buy this 

sophisticated piece of state-of-the-art technology, the Cameo 400 AV mobile. You have just 

purchased one of the most powerful products available for video applications. We're 

convinced that the Cameo 400 AV mobile will be both very useful and a lot of fun for you for a 

long time to come.  

Scope of delivery 

CAMEO 400 AV mobile ��
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Multi-connector cable 

Composite cable 

S-video cable 

Stereo audio cinch cable 

Scart-composite/S-video/audio cinch (RCA) adapter 

Ulead DVD MovieFactory 2 SE  

Ulead VideoStudio 7 SE DVD 

This manual 

Registration card with the serial number 

Key Features & Specification 

PCMCIA card hardware MPEG encoder 

S video, composite and stereo audio inputs 

DVD, SVCD and VCD Authoring 

On-the-fly DVD creation 

Ulead VideoStudio 7 SE DVD and DVD MovieFactory 2 SE 

Recording plug-in for Ulead software  

TerraTec recording and playback application  
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Product description 

Transform your notebook into a mobile video editing studio 

The Cameo 400 AV mobile lets you turn your notebook into a mobile studio for digitizing and 

editing your videos. Simply connect a video source such as a video recorder, DVD player, 

camcorder or sat receiver to your notebook via the PCMCIA interface. The Cameo 400 AV 

mobile directly converts video signals to MPEG2/1 format, delivering high quality even at low 

bit rates. This does not result in undue CPU loads, as the MPEG compression is performed by 

the PCMCIA card itself. 

You're the director! 

In addition to the Cameo 400 AV mobile application for recording and playback in a variety of 

formats and resolutions, the package contains Ulead Video Studio 7  and MovieFactory 2—

video editing and DVD authoring applications that let you create true blockbusters out of your 

video material. A plug-in lets you access the Cameo 400 AV mobile directly to store your 

motion pictures on the hard drive or even burn them onto a DVD on the fly. With VideoStudio 

7 SE DVD, you can edit, trim and organize your video clips and add music, voice-overs and 

titles. Special effects, cross-fades and filters are available for the finishing touches. And the 

best thing about it: everything works in real time, without annoying processing delays. 

That's the wrap?  

Then onto a DVD or (S)VCD with it. Thanks to Ulead Movie Factory 2, you can even burn your 

work on the fly. You can also add professional menus to your DVDs, as well as frames, 

buttons and backgrounds. All with just a few clicks of the mouse.  
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Product illustration 

 

�������

 

�  S-video In 

�  Stereo audio In  

�  Composite video In 

Using the Cameo 400 AV mobile PCMCIA card for the first time  

The PCMCIA card is extremely simple to install. The installation can be completed without 

shutting down your computer. Connect the multi-connector cable to the Cameo 400 AV 

mobile. Insert the included installation CD in your CD drive. Insert the Cameo 400 AV mobile, 

connector strip first, into the PCMCIA slot of your computer until the card is firmly seated. Your 

notebook will recognize the new hardware and launch the installation wizard.  

6  Cameo 400 AV mobile (English) 



  

 

Installing the drivers 

Driver installation under Windows XP 

 

Please choose “Install from a list or specific location (Advanced)”.  

Please click “Next”. 

 

  

Select the upper item and browse your installation CD.  
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Driver installation under Windows 2000 

  

  

Let your system search for a suitable driver. Confirm by clicking “Next”. 

  

Select your CD-ROM drive and click “Next”. 
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Digital signature in Windows XP and 2000 

  
 

Continue the installation. The driver can be installed despite the lack of signature. The 

missing signature has no effect on the quality or functionality of the driver. 

Installed drivers should look like this. 

 . 

To open the Device Manager, press and hold the Windows key (with the Windows logo) and 

press the Pause key. This opens the System Properties window. Click the “Hardware” tab and 

then the “Device Manager” button. 
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Installing the software 

Inserting the installation CD will automatically launch an installation program. If this is not the 

case, please manually execute AUTORUN.EXE in the root folder of the CD. 

While the installation program will take care of most of the work, we were not able to 

automate everything for you. A number of points must be observed to that the installation is 

set up correctly the first time around. 

Installing DirectX 9  

We realize that things don't always go as planned. With the introduction of DirectX 9, 

Microsoft offers many improvements and bug fixes that are essential for digital video editing. 

Please install this update first! 

Installing the Cameo 400 AV mobile application  

Install the application from the included installation CD.  Simply follow the instructions 

provided. More information on the software will be provided later under “The software in 

detail”. 

Installing the Cameo 400 AV mobile plug-in 

This plug-in gives you direct access to the Cameo 400 AV mobile from the Ulead software. 

Install it from the Installation CD and it will be available from within the video editing 

software.  

Installing Ulead DVD VideoStudio 7 SE and MovieFactory 2 SE 

Install VideoStudio and DVD MovieFactory 2 SE from the installation CD. Simply follow the 

instructions provided. 

 

 Detailed manuals for both Ulead applications can be found on the installation CD.  
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The software in detail 

Cameo 400 AV mobile application  

Use this simple tool to record and play back your videos.  

 

  

A Repeat G Recording 

B Rewind H Sound on/off 

C Playback I Snapshot 

D Pause J Volume 

E Fast forward K Settings 

F Stop   
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Video recording 

Connect your analog video source to the Cameo 400 AV mobile. When using the composite 

video input (�), a preview will be displayed in the preview window.  

   
  

The display will show the video input and quality level you have selected.  

To change the settings, click the tool icon (K). A new window will open: 

  

Here you can select composite video or S video as the connection for your analog video 

source, adjust the color or activate DXVA. DXVA (DirectX Video Acceleration) supports video 

editing directly on the graphics hardware to reduce CPU loads and improve video perform-

ance. According to Microsoft, this lets slower, less power-hungry processors play back video 

with significantly higher quality than previously deemed possible. DXVA will be disabled 

automatically if your graphics board does not support this Microsoft standard.  
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Next, select the “Record” tab.  

  

Here you can configure all of the settings relevant to recording. Select the save location, file 

name type and recording quality.  

 “HQ” (highest quality), “SP” (medium) and “LP” (space-saving) are DVD-compliant. We 

recommend selecting a suitable quality level on a case-by-case basis, as the video file sizes 

increase with the quality. In addition, you can also record in MPEG1 format. Use this file 

format for space-saving video CDs.  DVD Movie Album is specific to the Panasonic application 

of the same name for creating DVD-RAMs. When this option is selected, an additional .MTV 

file needed by the Panasonic application will be created automatically in addition to the 

recorded video file.  You will not need .MTV files if you are using a DVD – or + recorder.  

Once you have taken care of the settings, you can get started right away. Simply click the 

Record button (G) and away you go. To view the recorded video, please click the playback 

button (C). Select the folder in which you have saved the video.  

Editing your video files and creating DVDs or video CDs is no problem with the included Ulead 

applications.   

We have developed a plug-in to let you access the Cameo directly from Ulead VideoStudio. 
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Cameo 400 AV mobile plug-in in Ulead VideoStudio 7 

After installing VideoStudio 7 and the Cameo 400 AV mobile plug-in, you can record directly, 

without the need for software conversion of the video. You must select the recording plug-in 

for this purpose, however.  

1. Start Ulead VideoStudio 

2. Select File -> Recording Plug-In 

3. Select Cameo 400 AV mobile plug-in and click OK. 

That's it. Naturally, you can also change other settings.  

1. Switch to the recording mode. 

2. Select Options -> VideoFormat 

Specify the quality of your recording here. As always, the higher the bit rate, the better the 

quality, and the larger the file size. However, the Cameo 400 AV mobile also delivers surpris-

ingly good results at low bit rates.  

  

Additional configuration options are available under Options -> Video Source. Here you can 

select the input (S video/composite) that you are using to connect your analog video source 

to the Cameo 400 AV mobile. 

The recording plug-in is also available in Ulead MovieFactory, of course. Please refer to the 

installation CD for detailed documentation of the Ulead applications. 
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Service at TerraTec. 

Nothing seems to work!—This can happen even on the best systems. If this happens to you, 

the TerraTec team is happy to offer its service and support.  

Hotline, Internet. 

If you have a tough problem—where you cannot solve the problem yourself, the support in 

this manual doesn't resolve the problem, and your dealer can't fix it either—please contact us 

directly.  

If possible, try our Internet support system first: under http://www.terratec.com/ you 

will always find current answers to frequently asked questions (FAQ). 

If these options do not provide the necessary help, please contact our phone hotline. You can 

also reach us online. To do so, visit us at http://supporten.terratec.net/. 

In either case, please have the following information handy: 

your registration number, ��

��

��

��

this documentation, 

the manual of your motherboard, and 

a screen shot of your BIOS configuration, if possible. 

In addition, it would be helpful to our technicians if you are at your computer during the 

phone call so that you can carry out our tips and tricks directly. Please do not forget to write 

down the name of the respective support technician if you contact our Support Team.  

 You will need this name if a defect is present and your card needs to be mailed to us. 
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Broken?! 

Before you send the card back, be sure to contact us! Make a note of the name of your 

support contact and follow these simple instructions: 

Please fill out the service request form provided with your card clearly and completely. 
The more clearly and detailed you describe the problem, the faster we will be able to help. 
Cards sent in without a description of the problem cannot be processed and will be re-
turned to you at your expense.  

��

��

��

��

Be sure to include a copy of your purchase receipt (not the original) with the package. If 
we do not receive a copy of a receipt, we will assume that the warranty for the product has 
expired and will bill you for the repair. 

Please use a sufficiently strong and padded mailing package. We recommend using the 
original package. Remember that the card is a sensitive electronic component. 

Be sure to include enough postage—we will cover for the postage for the return to you. 

 

 ;-) 
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General terms and conditions of service 

1. General 

You accept our general terms and conditions of service by purchase and receipt of the 

goods. 

2. Proof of warranty 

You will require a copy of the purchase receipt or delivery slip as proof of warranty. If you 

do not supply proof of warranty, we will charge for repairing the goods. 

3. Description of fault 

Shipments that do not include a description of the fault or an insufficient description 

('defective' or 'for repair' is insufficient) will be returned for a processing fee, because this 

makes repair more difficult and could have been avoided. 

4. Unfounded complaints 

In the event of an unfounded complaint (no fault could be detected, probable operating 

error), we will return the goods and a processing fee will be charged. 

5. Packaging 

If possible, please use the original packaging for return shipment. Any warranty claim will 

be jeopardized by improper packaging. The warranty will not apply to damage caused by 

improper packaging. 

6. Third-party products 

Devices that are not manufactured or distributed by TerraTec Electronic GmbH will be 

returned and a processing fee will be charged. 

7. Chargeable repairs 

Repairs outside the warranty period are chargeable. 

8. Shipping costs 

The dispatcher pays all costs associated with shipping and insurance for the goods for 

repair to TerraTec Electronic GmbH. If the goods are covered by warranty, TerraTec Elec-

tronic GmbH will pay the shipping costs for returning repaired goods. COD shipments will 

not be accepted for organizational reasons. 

9. Final clause 

TerraTec Electronic GmbH reserves the right to change or supplement the general terms 

and conditions of service at any time. 

 

Otherwise the General Terms and Conditions of Business of TerraTec Electronic GmbH are 

considered to be accepted. 
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Glossary 

AVI – A Windows video format. 

Bit rate – The bit rate indicates the volume of the data stream per second. A higher bit rate results in 

higher quality. A distinction is made between constant bit rates (for -> VCD, for example) and variable bit 

rates, e.g. for -> SVCD and -> DVD. Unlike constant bit rates, variable bit rates adjust the size of the data 

stream according to the video material. 

Blue screen – A variation of -> Chroma keying 

Capture – Recording. 

Chroma keying – Chroma keying uses a surface with a single color in front of which an actor, for 

example, is filmed. This color area is then made transparent during subsequent editing and can be 

replaced by a different background. 

Chrominance – Chrominance refers to the color signal in -> YUV, which is comprised of two color 

components: U, the balance between red and cyan, and V, the balance between yellow and blue. 

Clip – A short piece of video material. 

Composite video – Composite video is a transmission method common in the consumer sector that is 

generally realized using cinch connectors and which is frequently used, for example, on TVs. In this 

process, all signals (chrominance and luminance) share a single cable. The quality of composition video 

is lower than that of -> S-video, for example, in which chrominance and luminance are transmitted 

separately. 

CPU – Central processing unit. The part of your computer (the processor, i.e. Pentium or Athlon) that 

does the actual computing. 

D8 – Digital 8 is the successor to the Hi8 and VHS-C camcorder formats. Hi8 or D8 cassettes are still 

used, but the video data is recorded digitally in DV format. 

Data throughput – see Data transfer rate  

Data transfer rate – The data transfer rate describes the speed at which a hard drive can read or write 

data over a sustained period. The data transfer rate is usually measured in seconds, e.g. 7 Mbps. 

Device control – In DV terms, this refers to the ability to control your camcorder from your PC. 

DirectDraw – This is a graphics standard that was initially developed by Microsoft. Its features include 

the capability to write graphics data directly to the memory of the graphics board for the fluid display of 

video material. 

Dropped frames – These are individual images missing from the video data stream, usually due to a 

slow hard drive. 

DV – DV stands for Digital Video. The DV standard uses a compression rate of 5:1. This corresponds to a 

data rate of 3.125 Mbps, which can be handled by virtually all newer hard drives. The quality of the DV 

standard is very high; it is therefore frequently used in professional productions. A number of different 

cassette types exist in the DV sector, which vary in size and maximum playing time, but which are 

compatible with one another in terms of video data. MiniDV is designed for the consumer sector and 

supports playing times of up to one hour. The DV format used in the professional sector supports 

playing times of up to three hours.  
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DVD – Abbreviation for “Digital Versatile Disk”. The diameter of a DVD is the same as that of a CD-ROM. 

Current DVD specifications cover storage capacities ranging from 4.7 GB (DVD-5) to 17 GB (DVD-18) and 

data rates between 600 and 1,300 Kbps. Distinctions are also made between a variety of formats such 

as DVD Video, DVD Audio, DVD-ROM, DVD-R, DVD-RW and DVD-RAM. 

DV-In  – Usually, the DV jack of a camcorder can transport video data in both directions— to and from 

the camcorder. Many camcorders in Europe do not feature DV-In, however. Also see -> Enabling. 

Enabling  – Due to European import duties, imported digital video recorders are more expensive than 

imported digital video playback devices. For this reason, manufacturers of camcorders have begun to 

modify their products for the European market and to disable the digital input -> DV-In. Needless to say, 

clever developers found a way around this restriction very quickly. This is known as “enabling”. Enabling 

the DV camcorder is a precondition for sending video material back to the camcorder. Enablers are 

available for almost all camcorders and can be purchased freely. 

Fade – see Fading 

Fading – Fades are soft transitions, often involving special effects, from one clip to the next. 

Fields – Rather than displaying 25 frames per second (as per the PAL standard), 50 fields are displayed 

per second to reduce TV display flicker. These fields consist of either the odd-numbered rows (these are 

sent first) or the even rows of the image being displayed. 

FireWire™ – Apple's name for -> IEEE-1394  

Frame rate – The number of frames within a given period of time. The frame rate is frequently stated in 

frames per second (FPS). 

Hi8 – Analog video recording system that separates color and brightness information, thus offering 

quality better than that of VHS-C, for example. 

Hosiden connector – A small connector with four conductors used for -> S video signals. 

IEEE -1394 – This is a universal bus system originally developed by Apple for digital data communica-

tions. The devices are connected by cables with a maximum length of 4.5 m. The system supports 

transfer rates of up to 400 Mbps. However, a standard has not been established for video data due to 

the lack of specifications for the format of video data using this bus. Sony got down to brass tacks and 

closed this gap by installing FireWire™ sockets in its digital camcorders and developing its own 

protocol. Thanks to FireWire™ and the Sony protocol, the dream of loss-free video editing has finally 

come true. 

iLink – Sony's name for -> IEEE-1394  

Interlacing – see Fields 

Linear editing – The origins of linear video editing date back to analog video. The original video data is 

generally present in the same sequence as the edited video clips. A simple type of linear editing would 

be, for example, transferring video material from an analog video camera to a video recorder while 

discarding a number of clips. If you then insert a new clip in the middle, however, all of the following 

clips will also require editing. 

Luma keying – Unlike chroma keying, the transparency of the video is determined on the basis of 

brightness in luma keying. 

Luminance – Luminance refers to brightness in -> YUV. (Y) 

Main memory – see RAM 
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MiniDV – The consumer version of the DV format. Also see –> DV. 

MiniDVD – This is a process in which -> DVD data, including the DVD directory structure and navigation 

menu, is burned onto a blank conventional CD. Due to their lower capacity, MiniDVDs can only store 

around 18 minutes of video data. Unfortunately, not many DVD players support MiniDVDs. This format is 

best suited for playback on PCs for this reason.  

MJPEG – Motion JPEG is a compression process in which every single frame in the video data stream is 

compressed individually. 

MPEG – The Motion Picture Experts Group is a consortium of leading manufacturers and developers of 

video technology that determines new standards such as MPEG-1 or MPEG-2. 

Nonlinear editing – Unlike -> linear editing, individual clips can be edited without affecting subsequent 

clips. For example, with nonlinear editing, you can shorten or remove a clip at the beginning of a video 

project without having to edit the following clips as a result. 

NTSC – NTSC is the video standard used, for example, in the USA and Japan. NTSC has a higher frame 

rate than PAL (30 frames or 60 -> fields per second), but a lower resolution (525 rows, with 480 visible). 

Color depiction in NTSC is realized in -> YIQ. 

PAL – This is the most common video standard in Europe. PAL displays 25 frames (or 50 -> fields) per 

second and has a resolution of 625 rows, of which 576 are visible. Color depiction in PAL is realized in -> 

YUV. 

Preview – The preview offers you a quick overview of your work. The final quality is normally considera-

bly higher than that of the preview. 

RAM – Random Access Memory is the main memory of your PC. Since video editing with effects is very 

memory-intensive, the old rule applies: you can never have enough RAM! 

Rendering – this refers to the processing of video or audio clips after an editing operation has been 

completed, for example after the application of an effect or filter. 

RGB color space – In the RGB color space, each visible pixel is made up of the three components R(ed), 

G(reen) and B(lue). To achieve the natural display of colors on a computer, each of these components 

must have at least 256 values. This corresponds to exactly one byte for each color component. A single 

complete video image would thus require 768 pixels x 576 pixels x 3 bytes = 1,327,104 bytes. This 

corresponds to around 1.2 MB per frame! One second of video in the RGB color space would therefore 

require around 31.6 MB of storage space. Using this process, a 2 GB hard drive would have a video 

capacity of around one minute. No current hard drive can deliver this volume of data in real time, but a 

number of options are available to reduce the data volume of the video signal substantially through 

transformation to a different color space (usually YUV) and compression (usually MJPEG).  

Saturation – Describes the share of color in the picture. 

Storyboard – Unlike the -> timeline, the storyboard offers a thematic overview of your video project. 

Individual scenes can be identified easily, but it does not deliver a sense of the actual length of the 

project. 

SVCD – Abbreviation for Super Video CD. SVCDs are similar to -> VCDs, but they have a great advantage 

in that their data is in MPEG-2 format with a -> variable bit rate. In addition, the resolution of 480 x 576 

pixels is higher than that of the VCD. An SVCD generally can contain 45-50 minutes of video material. 

The bit rate (audio and video) of an SVCD may not exceed 2.6 Mbps. SVCDs can be viewed using many 

standalone DVD players. 
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S-video – Unlike -> composite video, chrominance and luminance are transmitted separately in S-video, 

resulting in higher quality. 

Timeline – The timeline is the time axis upon which you position and edit your video clips. 

Transition – see Fading 

Trimming – This refers to adjusting the length of a video clip at the beginning and/or end. 

VCD – Abbreviation for Video CD. The Video CD has a PAL resolution of 352 X 288 pixels and stores 

audio and video data in MPEG-1 format. VCDs use a constant -> bit rate of 1.15 Mbps for video and 224 

kbps for audio data. VCDs can be viewed in virtually any DVD player. 

Video filter – Video filters let you influence your video material in a wide range of ways. For example, you 

can manipulate the colors of your video film or use complex filters to degrade your new, top-quality film 

to look like an old, silent movie. 

Video for Windows – This is an old, but still commonly used, video concept for Windows. 

YIQ – YIQ is a color space related to -> YUV. It is also characterized by a brightness component -> 

luminance (Y), but also by different color components, I (cyan-orange balance) and Q (magenta-green 

balance). YIQ is used for -> NTSC, for example. 

YUV – YUV is the designation for a color space characterized by a brightness component -> luminance (Y) 

and two color components -> chrominance (U, V). 
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